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Dear Alisha DSouza,

Thank you for providing editorial comments and the set of four reviewer comments for our
recent manuscript submission, “Interactive Molecular Model Assembly with 3D Printing”.
Having been our first submittion to JOVE, it was encouraging to see the positive responses
from all those involved.

Here, we address both the Editorial staff comments and reviewer requests. In general, there
can be summarized as a desire for some additional details, citations, and context. We
highlight the manuscript changes in this response document, with excerpts from the
revised manuscript. We hope these edits meet both reviewer and editorial expectations for
a successful and impactful JoVE publication.

With best regards,
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Christopher Fennell, PhD

Department of Chemistry
Oklahoma State University

CC: Elham Fazelpour



Editorial Comments:

e Please take this opportunity to thoroughly proofread the manuscript to
ensure that there are no spelling or grammatical errors.

We have made an effort to address potential spelling and grammar issues with this
revision.

e Protocol Detail: Please note that your protocol will be used to
generate the script for the video, and must contain everything that you
would like shown in the video. Please add more specific details (e.g.
button clicks for software actions, numerical values for settings, etc)
to your protocol steps. There should be enough detail in each step to
supplement the actions seen 1in the video so that viewers can easily
replicate the protocol.

1) Section 1: Please specify all button clicks and menu selections for
all software steps.

2) 3.3: Mention sand paper grit and buffer wheel speed.

Further protocol details have been provided, this with a focus on using the Simplify3D
4.1.2 software. While we did not strongly highlight the use of this specific software in
the manuscript text, we agree that a very specific case in the manuscript could be
beneficial to readers. We also provide more specific protocol details for activities that we
originally deemed general, this with some descriptions of motivations. Highlighted
excerpts of several of these changes are as follows, though there are more such changes
in the revised manuscript. They hopefully provide even clearer guidance to readers/
viewers:

“...with specific considerations given for representative models shown with the
Simplify3D 4.1.2 software and MakerGear M2 FDM 3D printers. Dedicated manufacturer
directions...”

“1.2  Import one of the C_atom_sp3, H_atom, or C-C_bond files into your slicer
program. Use millimeter format for the units if an option is available. In Simplify3D,
either click the "Import" button of the "Models" panel of the main window or select the
"Import Models" command from the under the "File" pulldown menu. Select the
appropriate model file from the resulting file browser.”

“1.3  Scale the imported model to the desired size. In Simplify3D, double-click either
the graphical model in the main display or by double-click the listed model in the
"Models" panel of the main window. This action opens a model editing panel that
enables translation, rotation, and scaling of the target model. Representative models are
presented for 50%, 100%, 200%, and 320% scale for all interconnecting parts.”

“1.4 Duplicate models to generate an array of models as desired by selecting the
"Duplicate Models" option from the "Edit" menu of Simplify3D and entering the number
of model parts in the resulting dialog box. Arrange the model(s) near the center of the



build platform by clicking the "Center and Arrange" button in the "Models" panel of the
main window, or by selecting the "Center and Arrange" option under the "Edit"
pulldown menu. See Figure 1 for an example printed arrangement of six C_atom_sp3
models printed with PLA (polylactic acid).”

e Protocol Numbering: Please adjust the numbering of your protocol
section to follow JoVE’s instructions for authors, 1. should be followed
by 1.1. and then 1.1.1. 1if necessary and all steps should be lined up at
the left margin with no indentations. There must also be a one-line
space between each protocol step.

We have identified and corrected deviations from the JoVE instructions for protocol
numbering and display. This included correcting a missing blank space between two
protocol items and a refinement of numbering categorization for specific protocol
actions.

e Protocol Highlight: The highlighted steps should form a cohesive
narrative, that is, there must be a logical flow from one highlighted
step to the next.

For the protocol, we have highlighted the main numbered steps and taken care to
ensure that the protocol presentation will be cohesive from a video recorded standpoint
with an example 3D print. Such highlighting has been extended to include the main
protocol section numbers/headers as recommended in the Instructions for Authors.
Given JoVE’s complementary manuscript + video communication. We have highlighted 3
sections of the Representative Results to emphasize the interactivity of the resulting
models. While not part of the Protocol section, showing video of such interaction with
resulting models will enhance the narrative by drawing connections to molecular
conformer sampling and the accessible phase space of the molecules.

e Discussion: JoVE articles are focused on the methods and the protocol,
thus the discussion should be similarly focused. Please ensure that the
discussion covers the following in detail and in paragraph form (3-6
paragraphs): 1) modifications and troubleshooting, 2) limitations of the
technique, 3) significance with respect to existing methods, 4) future
applications and 5) critical steps within the protocol.

We have enhanced the Discussion to better draw recommended connections with the
protocol.



Reviewer #1:

In the video article, the authors describe some molecular model
components which can be printed by a FDM 3D printer and used to create
molecular models of saturated hydrocarbons. This method 1is not new,
since it has been reported in many other protocols and publications.
Although the novelty 1is not mandatory for JOVE, in my opinion, the
efficacy of the protocol needs to be emphasized especially in sections 3
and 4.

Looking on JOVE website, I found a video that is quite similar to the
initial part of the protocol which authors would 1like to make (chapters
4 and 5).
https://www.jove.com/video/55427/3d-printing-of-biomolecular—-models—-for-
research-and-pedagogy

Said this, even if the "Preparation of model files for 3D printing"
section and the "Preparation of the printer for printing of parts"
section will be repeated, the third part of the manuscript deals with
the assembly of the model structures and the "representative results"
will be focused on the visualization of the properties of the
cyclohexane structure. These two aspects have not been visualized so
far, and I think that a video visualization of the interconversion
between cyclohexane boat and chair conformers represents a useful
novelty for teaching purpose.

My only suggestion during the realization of the video is to dedicate
more emphasis on 3rd and 4th section with respect to sections 1 and 2.

We appreciate the reviewer’s emphasis on originality and their efforts to frame the
presented work in context with existing literature efforts. We also feel the video the
reviewer discovered is relevant to the current effort, which is why that particular JoVE
publication was similarly discoverable by looking at the cited references our manuscript.
This earlier published effort focused on creating static printable representations from
PDB models of biomolecular structure files. We have taken care to focus more on the
practical considerations for reliable printing of dynamic and interactive molecular
structures, this with commodity 3D printers. This is likely why the reviewer recognizes
the value added from the latter sections of our manuscript.

We strenuously agree with the reviewer that highlighting of a dynamic application is a
critical aspect of this manuscript. JOVE is one of the few journals that directly integrates
video in a scientific report, and this provides an opportunity to communicate motion in
ways that are not possible with traditional scientific journals. While we were instructed
by the JoVE Editorial Staff to expand on the early portion of the protocol with additional
details, we have responded in a way that emphasizes the importance of the dynamical
aspects of constructed 3D molecular models.

The text of the manuscript 1is very clear and no modification is
required, I think that the manuscript can be accepted 1in its form. Some
important references are missing:
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We thank the reviewer for the suggestion of additional references. Some of these are
already cited but others do expand on the scope of the field of “molecules and 3D
printing”. It is better to consider more efforts to highlight relevant context, so we have
included many of these references in the revised manuscript.

Reviewer #2:

Manuscript Summary:

The authors present a method for 3D-printing molecular model systems
with improved functionality over previously 3d-printed molecular models,
in that the models can be adjusted to show various steroisomers. They
can also make these models in various sizes, which could be helpful for
classroom use (as you could print huge models for everyone to see). The
paper is thorough and the figures are well made. The procedure may be of
use to some educators who want to bring 3d-printing to their classroom
and promote tactile learning strategies, or possibly a researcher who
wants to display a molecule of interest. I recommend this manuscript to
be published in JoVE, as I believe it would be useful for many people
(teachers) unfamiliar with 3D-printing to be able to approach this
project and bring it into their classroom.

We appreciate the reviewer’s summary and opinion on the relevance of this work. The
reviewer has highlighted a key aim of this work, helping encourage researchers and
educators to make more regular use of 3D printing. As discussed in response to another
reviewers comments, JoVE provides a unique pathway for aiding this effort.

Major Concerns:

Penny et al (Journal of Chemical Education (2017), 94 (9),) published on
pretty much this same method, so have several others in the Journal of
Chemical Education (Dean et al Journal of Chemical Education (2016), 93
(9),). (Fourches, Denis; Feducia, Jeremiah. Journal of Chemical
Education (2019), 96) )

This needs to be cited and discussed. Mention the benefits that these
researchers found on using 3D-printed models in the classroom. compare
your models to theirs, if appropriate.



We already list and include the Penny et al. work in the manuscript, and we thank the
reviewer for mentioning other works that illustrate the impact that 3D printed molecular
structures can have in pedagogy. We have included extra references in the manuscript
introduction. To draw further distinction of these efforts from our presented work, we
further adjusted wording in the discussion to highlight the dynamical and interactive
qualities of the models presented in this work.

Reviewer #3:

Manuscript Summary:

The authors describe a procedure for printing 3D molecular models of
hydrocarbons. They provide printer files for carbon atoms, hydrogen
atoms, and bonds that can be assembled into any saturated alkane. The
abstract provides a thorough description of the manuscript. The title
could use a few more words describing the resulting models, since the
models are limited to sp3-hybridized organic molecules and won't be
useful to a reader hoping to use them to teach VSEPR theory, for
example.

The authors eloquently situate this work in the historical context of
molecular model-building. It is easy to think of molecular models as a
tool for beginners. The reminder that they were the basis of such
important breakthroughs as Pauling's work and the elucidation of the
structure of DNA is worthwhile. I think there is value in pointing this
out to our students. The authors are careful to acknowledge that these
models are not designed to provide novel structural insight, as is
appropriate.

The fact that these models can simulate the variation in barriers
between different conformational changes is particularly impressive.
Molecular models tend to be either static of floppy. The added tactile
feedback the authors report that these models provide should be a
valuable addition to the toolkit teachers can give students just
beginning to develop their intuition about molecular behavior.

The manuscript lists all of the required materials. The steps are
detailed and clear. I have a few suggestions for additions and changes
in emphasis that I describe below.

Learning to produce useful 3D prints comes with a steep learning curve.
The authors have addressed many of the most important issues that arise.
They provide details about how to arrange models on the build plate
(orientation can have a large effect on print quality) and what settings
to use (infill percentage is a guessing game to beginners). They discuss
how the models can be scaled. This is a particulary important issue that
I had to learn though much trial and error because carefully calibrated
gaps between snap-together parts behave differently at different
scalings.



We thank the reviewer for providing this detailed summary. They are simultaneously
demonstrating their expertise and highlighting aspects of the manuscript that we were
hoping to effectively communicate. 3D printing is a bit of a guessing game when it comes
to finding what reproducibly works, so our aim through JoVE is to potentially provide a
positive starting point for beginners, as well as some shared experiences for those
experienced with the struggles in achieving a quality finalized print.

Minor Concerns:

1.3.2. The authors state that rafts are not necessary at sizes above
100%. This may not be true for all printers. In my experience with a
Makerbot Desktop (PLA on unheated bed), a raft 1is essential for all
prints because the thicker layer of resin adheres to the painters tape
in a way that the thinner print layers seem incapable of.

We thank the reviewer for this comment. The first layer will make or break a 3D print.
We were careful to state that a raft “should not be necessary” as it isn’t from our
experience, though this requires a well adhered first layer. We have modified the text to
emphasize that rafts are generally useful. We also emphasized “First Layer Settings” in
the protocol. Excerpts from these changes are below.

“1.3.2 Activate a raft or brim structure for 100% and smaller scale models. Such
structures should not be necessary for most larger models as the flat base will have
sufficient contact with the bed surface to remain fixed in place. Rafts help provide a well-
adhered first layer for a 3D print, so if there are any difficulties in the stability of the first
printed layer at any scale, activating a raft structure could lead to more successful prints
at the expense of the material needed for the raft structure.”

and

“1.5.4 Set the "First Layer Speed" to a value between 25-50% in the "Layer" tab of the
process settings. A slowly printed first layer will improve adhesion to the print bed and
will result in more successful overall 3D prints.”

1.5.6. The authors describe slicing as a separate procedure. The
Makerbot software, which many viewers may be using, doesn't emphasize
the distinction between slicing and "preparing to print". The authors
may want to point out that some all-in-one software packages handle this
step internally.

We thank the reviewer for this comment. We have pointed out this distinction as part of
the Editorial staff recommendations for specific printing software actions in the protocol.



3.3.3. The authors describe an acetone dip polish, and later mention the
problem that arises when dipping parts with gaps. I wonder 1if the
authors have tried an acetone vapor polish instead. It might allow the
imperfect parts to be polished. (I have only printed with PLA, and
haven't tried it myself, so this just a suggestion.)

The reviewer is correct to point out vapor polishing as a strategy for finishing. It is a bit
slower and comes with the same cautions as liquid acetone processing. We have
modified the text to include vapor polishing cautions. The reference to it could lead a
reader/viewer to explore it if it if they have the means and appropriate environment.

“CAUTION: Acetone is flammable and should be applied sparingly in a fume hood or very
well-ventilated area. ABS dissolves in acetone, so parts with layer separation defects due
to poor annealing should not be treated with liquid acetone. Acetone will enter models
through such defects and dissolve the model infill (Figure 3C). Polishing with acetone
vapor is a slower process that will result in a similar effect, though safety precautions
should be taken given the flammability of acetone.”

My last concern is regarding the 1included print files. Producing models
that will print well and accomplish an intended goal presents a very
large learning curve to a new practitioner -- much larger than learning
to operate the printer. I understand that preparing models is beyond the
scope of this submission, but the fact that the set of models can only
be used to make saturated hydrocarbons is quite limiting. I also
understand that producing models of doubly-bonded molecules that
demonstrate the rotation barriers in the way these do is likely to be
significantly more difficult. But, I think it would be nice to at least
provide for the existence of heteroatoms. At a minimum, the authors
could suggest printing carbon atoms 1in other colors to represent
nitrogen, oxygen, and halogens. It would be a nice addition to provide
models for those elements with the appropriate valence. Or, as an
alternative, they could 1include a variation of the bond model that only
connects on one end, which could be used like the "nubs" that some
molecular modelling software uses to represent lone pairs.

We very much agree with the reviewer on the point of the limiting aspect of sp3
hybridized organic compounds. We noted that these parts are part of a larger kit that
(yes) has different atom that are sized according to Bondi radii, hybridized structures,
and dual-extruder lone-pair structures. These kits are used for demonstrations in
beginning General Chemistry courses at Oklahoma State University to aid in teaching of
VESPR theory, and we print expanded kits with these structures to give to lab visitors as
part of our chemical outreach activities. The presentation of these details are, however,
a bit outside the scope of the present study.



To accommodate the reviewer’s concerns, we have expanded sections of the text to
highlight the expandability of these models and how one can restrict rotation about
connection points with atom model adjustments.

“NOTE: Rotation about a connected bond is a desired feature for the provided parts and
models. Locking rotation requires an atom model (an sp2 hybridized carbon, for
example) with a fixed structure in the connection socket that inserts between the
spacings of the tabs on the end of the bond model.”

“...More quantitative insight along these lines requires more specific detail than the
considerations taken in building these model parts, but these models and
recommendations provide a foundation for general interactive physical investigation of
molecular systems. These models are an extension of 3D printable model kits we have
been producing for research and outreach activities for several years prior to this report,
and additional component parts that are compatible with both these models and the
described protocol are available from the authors to enable more diverse bonding
arrangements and dynamical action.”

Reviewer #4:

Manuscript Summary:

This paper reports on the development of a protocol for creating/
assembling molecular models using individual atom/bond pieces built
using 3D printers. The manuscript is well written, clear, concise, and
is of relevance for Jove and probably a relatively large audience in the
research/teaching community. The reviewer appreciated that all technical
aspects of the 3D printing process are covered (machines, filaments,
temperatures, etc.) as well as the fact that all STL files ensuring the
reproducibility/usability of this protocol are available in the Supp
Material. Therefore I think this paper could be accepted for
publication.

Major Concerns:
None

Minor Concerns:

I would suggest the authors to add one Figure representing their
protocol (pages 2-4) as a general workflow/diagram. It would be very
helpful for the readers I think.

We thank the reviewer for these comments. To address their concern, we have included
references that contain similar flow charts. Additionally, JoVE has an integrated video
component that is presented alongside the manuscript, and a flow diagram would
strengthen the presentation of this animation/video. We will work to incorporate this in
the video.



